
PRE-ORDER  
(QUICK REFERENCE GUIDE) 

 
 

STEP ONE: DESIGNATE PRODUCTS & PACKAGES FOR PRE-ORDER USE 
a. Click the “Setup” tab on the top. Click the “Product Management” tab on the 

left hand side. Click on the “Offers & Packages” tab, then click on the desired 
offer. 

b. Locate the desired package/product, then click on the “EDIT” tab. 
c. Click on the “Edit Package Settings” tab. 
d. Under the “Where do you want this package/product offered” section, select 

the “I want this package/product to be available for ordering online” option 
AND the “I want this package/product included for pre-orders online” option. 

e. Click the “Save Settings” tab at the bottom. 
 

STEP TWO: CREATE THE PRE-ORDER EVENT IN CORE 
a. Click on the “Events” tab at the top of the page, then click the “Click here to 

create new event” tab. 
b. Enter event information. Select the HQOE level at the bottom from the 

dropdown, then click the “Next” tab. 
 

STEP THREE: SETUP THE PRE-ORDER EVENT IN CORE 
a. Confirm correct event settings and change if needed. 

i. Under the “Event Settings” tab, make sure the “Enable Lab Auto-
Cropping of Group Images” box has been checked, then click 
the “Save Settings” tab. 

b. Confirm correct tax & shipping settings and change if needed. 
i. Under the “Tax and Shipping Tab”, select the desired tax rate for the 

event, then click the “Save” tab. 

c. Select applicable online settings for pre-order 

i. Select the “Online Settings” tab. Under the “General Settings” section, 

deselect the “Customers can find their proofs by last name” box. Then 

select the “Enable Pre-Orders” box. 

ii. In the pink box, type “OK” in the text box to confirm pre-order activation. 

iii. Adding a pre-order placeholder image (optional) :  Add the event Order 

Number, Roll and Frame where the desired placeholder image is located. 

iv. Adding a pre-order message (optional): Type desired message in “Pre-

Orders Event Message” box. 

v. Click the “Save Settings” tab at the bottom. 

 



 

d. Select applicable offer and input all titling, caption and crest data. 

i. Click on the “Offer Setup” tab, click on the “Which offer would you like 

to use for this event?” dropdown, then choose the applicable offer. 

ii. Fill in all Caption/Titling data & select all applicable product crests. 

iii. When finished, click the “Save” tab at the bottom. 

e. Select a modifier for the event. 

i. Select the “Edit Teams/Category” tab on the left hand side, then click the 

“Edit/Add Divisions” tab. 

ii. From the “Modifier” dropdown, select the applicable modifier then click 

the “Save” tab. 

STEP FOUR: ENABLE EVENT ON RETAIL 
a. On the “Event Details” screen, click the “Enable event on Retail” tab. 
b. Click on the “Event Details” tab on the left hand side to refresh the screen, then 

click on the “Preview Event” tab at the bottom. 
 
STEP FIVE: CREATE SPLASH PAGE WITH PRE ORDER LINK 

a. On the homepage of the BizHub, click on the “Quick Links” tab, then select the 
“Marketing: Organization Splash Screens” tab. 

b. Click on the “Create New” tab, then on the next screen click the “Create New 
Splash Page Now” tab. 

c. Enter applicable data under “Shoot Information” section, then enter an event 
specific message AND the pre-order HTML code under the “Important Picture 
Day Information” section. 

i. Use the link below to insert into the pre-order HTML code. Replace the 
information highlighted in yellow with the specific event ID (this will 
change every time) and the franchise specific CCS account number. 
http://tss.partypics.com/QPPlus/SearchNames.aspx?EventID=1554068&_Accou

ntNumber=91030 

ii. Paste the link above with event specific ID and specific franchise CCS 

account number, into the YELLOW section of the HTML code listed 

below:  

<a href="http://tss.partypics.com/QPPLUS/Packages.aspx"><h1 

style="font-size:175%">CLICK HERE TO PREORDER YOUR PICTURES 

NOW</h1></a> 

iii. Once the pre-order web link has been pasted into the HTML code, copy 

the ENTIRE HTML code and paste it into the “Important Picture Day 

Information” section of the splash page. Next click on the “Save 

Changes” tab. 

http://tss.partypics.com/QPPlus/SearchNames.aspx?EventID=1554068&_AccountNumber=91030
http://tss.partypics.com/QPPlus/SearchNames.aspx?EventID=1554068&_AccountNumber=91030


d. Upload any other desired documents by clicking the “Add/Remove Upload 

Documents” tab under the “Uploads” section. 

i. Click the “Choose File” tab. Browse for the desired document. Select the 

document and click the “Open” tab. Once the document has been 

selected, click on the “Upload” tab. 

e. Display the newly uploaded documents by clicking on the “Add/Edit Links on 

this Splash Page”. 

i. From the “File” dropdown, select the file that you uploaded in the 

previous step. Type in link text in the “Link Text” box, then click the 

“Add” tab. Link will then appear in the box below. 

ii. When finished, click the “Back” button on your browser to return to the 

splash page control screen. 

f. To add product images to the splash page, click on the “Update product 

spotlight” tab in the “Product Spotlight” section. 

i. Click on the “Search By” dropdown menu and select the method you 

want to search products by. Enter the appropriate data in the “Enter 

Description” box. Select the appropriate product when the text 

description populates in the “Select Product to Add” screen. When the 

correct product image populates in the “Product Spotlight” area, click 

the “Save Changes” tab. 

ii. Click the “Back to Splash Page Admin” tab to get back to the splash page 

control screen. 

iii. Once the splash page build is complete, click on the “Preview” tab at the 

top to see a preview of the splash page. 

g. Send either the splash page URL or the web HTML code to the 

league/organization director. They can in turn either post it to the organization 

web page OR send the URL link to all of the parents in the organization. 

i. To copy and paste the URL: On the splash page preview screen, copy the 

URL for the splash page, then paste it into an email to the 

league/organization director. 

ii. To copy and paste the HTML web code: Click on the “Web Code” tab at 

the top. On the next page, select the TSS Logo you want displayed, then 

highlight and copy the web code that appears in the box below. Paste the 

web code into an email and send to the league/organization director. 

STEP SIX: COLLECT PRE-ORDER DATA ON PICTURE DAY 
a. Use the “Pre-Order Tracking Form” to collect subject first and last name, subject 

image number, subject division and subject modifier on picture day. 
b. Each camera station should have multiple copies of this form. 



 
STEP SEVEN: MERGE PRE-ORDER DAY WITH PICTURE DAY ORDER DATA 

a. Type all of the pre-order data (subject first and last name, subject image 
number, division and division modifier) into the same spreadsheet used to 
process picture day orders. 

b. Upload images. 
i. For detailed instructions on how to do this, please refer to the 

“Uploading Images” section in either the “Standard Order Entry” or the 
“Green Screen Order Entry” section of the CORE Manual. 

c. Lock rolls & align images. 
i. For detailed instructions on how to do this, please refer to the “Locking 

Rolls & Aligned Images” section in either the “Standard Order Entry” or 
the “Green Screen Order Entry” section of the CORE Manual. 

d. Upload the spreadsheet (with the Pre-Order Data Included). 
i. For detailed instructions on how to do this, please refer to the 

“Uploading the Spreadsheet” section in either the “Standard Order 
Entry” or the “Green Screen Order Entry” section of the CORE Manual. 

e. Import pre-orders. 
i. Click on the “Imported Orders” tab on the left hand side, then click on 

the “Import Pre Orders” tab at the top. 
ii. Match all pre-orders with the applicable name from the name dropdown 

menu, then click on the “Save Name Assignments” tab. 
f. Transfer & identify group images. 

i. For detailed instructions on how to do this, please refer to the 
“Transferring & Identifying Group Images” sections in either the 
“Standard Order Entry” or the “Green Screen Order Entry” section of the 
CORE Manual. 

g. Queue Orders for Transmit. 
i. For detailed instructions on how to do this, please refer to the “Queuing 

Orders for Transmit” section in either the “Standard Order Entry” or the 
“Green Screen Order Entry” section of the CORE Manual. 

h. Transmit orders. 
i. For detailed instructions on how to do this, please refer to the 

“Transmitting Orders” section in either the “Standard Order Entry” or 
the “Green Screen Order Entry” section of the CORE Manual. 

 
 

 

    



PRE-ORDERS 

 

1. DESIGNATE PRODUCTS & PACKAGES FOR PRE-ORDER USE 

IMPORTANT: Packages, products and offers must be designated for pre-order use before they can be 

used for that purpose.   

IMPORTANT: This designation is done on a “per product/package” basis. It must be done for every 

product and/or package that is desired for pre-order use.  

3 WAYS TO SET UP THE PRE-ORDER OFFER: 

ONE: Utilize your standard offer and just make sure each desired pre-order product and package 

has the pre-order designation. (THIS IS THE BEST METHOD PROVIDING PRE-ORDER PRICING IS 

CONSISTENT WITH PICTURE DAY PRICING) 

TWO: Create pre-order products and packages within your standard offer by copying the desired 

products and packages, then giving each product/package the pre-order designation. (THIS IS 

THE BEST METHOD PROVIDING PRE-ORDER PRICING IS DIFFERENT THAN PICTURE DAY PRICING) 

THREE: Create a stand-alone offer specifically used for pre-order use. (WITH THIS METHOD, IT 

WOULD BE NECESSARY TO CHANGE THE OFFER ON THE EVENT BEFORE PICTURE DAY ORDERS 

COULD BE PROCESSED) 

HOW TO GIVE A PRODUCT/PACKAGE A PRE-ORDER DESIGNATION: 

STEP ONE: Click the “Setup” tab on the top. Click the “Product Management” tab on the left hand side. 

Click on the “Offers & Packages” tab, then click on the desired offer.  

 

 

 

 

 

 

 

 



STEP TWO: Locate the desired package/product, then click on the “EDIT” tab. 

 

 

 

 

 

 

 

STEP THREE: Click on the “Edit Package Settings” tab. 

 

 

 

 

 

 

 

STEP FOUR: Under the “Where do you want this package/product offered” section, select the “I want 

this package/product to be available for ordering online” option AND the “I want this 

package/product included for pre-orders online” option. 

 

 

 

STEP FIVE: Click the “Save Settings” tab. 

 

 

 

FOR DETAILED INSTRUCTIONS ON HOW TO BUILD AN OFFER, PLEASE REFER TO THE OFFER SETUP SECTION IN THE CORE MANUAL 



2.  CREATE THE PRE-ORDER EVENT IN CORE 
 

STEP ONE: Click on the “Events” tab at the top of the page, then click the “Click here to create 
new event” tab. 

 
 

 

 

 

 

 

 

 

 

STEP TWO: Enter event information. Select the HQOE level at the bottom from the dropdown, 
then click the “Next” tab. 
 

 

 

 

 

 

 

 

 

 

 

 



3.  SETUP THE PRE-ORDER EVENT IN CORE 

NOTE: From the event menu on the left hand side, there are 5 steps to completing the event 

setup. 

1. Confirm correct event settings and change if needed 

2. Confirm correct tax and shipping settings and change if needed 

3. Select applicable online settings for pre-order  

4. Select applicable offer and input all applicable titling, caption and crest data 

5. Select a modifier for the event 

 

 

 

 

 

 

ONE: CONFRIM CORRECT EVENT SETTINGS AND CHANGE IF NEEDED 

STEP ONE: Under the “Event Settings” tab, make sure the “Enable Lab Auto-Cropping of 

Group Images” box has been checked, then click the “Save Settings” tab. 

 

 

 

 

 

 

 

 
NOTE: Failure to complete this step could potentially result in having to spend a significant 

amount of time custom cropping each group image, for every product variation. 



TWO: CONFIRM CORRECT TAX & SHIPPING SETTINGS AND CHANGE IF NEEDED 

STEP ONE: Under the “Tax and Shipping Tab”, select the desired tax rate for the event, then 

click the “Save” tab. 

 

 

 

 

 

 

 

 

 

 

 

THREE: SELECT APPLICABLE ONLINE SETTINGS FOR PRE-ORDER 

STEP ONE: Select the “Online Settings” tab. Under the “General Settings” section, deselect the 

“Customers can find their proofs by last name” box. Then select the “Enable Pre-Orders” box. 

 

 

 

 

 

 

 

 



STEP TWO: In the pink box, type “OK” in the text box to confirm pre-order activation.  
 
 
 

 

 

NOTE: A custom pre-order place holder image can be added if desired. This image must be added to an 

event before it can be designated as the placeholder image.  

STEP TWO A (OPTIONAL): Adding a Pre-Order Placeholder Image :  Add the event Order Number, Roll 

and Frame where the desired placeholder image is located. 

 

 

 

 

 
NOTE: You can create a custom image specifically for the pre-order page. You can download a template 

for this purpose on the BizHub (Library/CORE Training/Pre-Order Resources/Pre-Order Image). 

NOTE: If no custom image is selected, then the default pre-order image will apply. 

 

 

 

 

 

 

 

 

 

 

Custom Image Default Image 



NOTE: A Pre-Order Event Message can also be added: 

 

 

 

 

 

 
 

STEP THREE: Once all desired data has been entered, click on the “Save Settings” tab at the 

bottom. 

 

 

 

 

 

FOUR: SELECT APPLICABLE OFFER AND INPUT ALL TITLING, CAPTION AND CREST DATA 

 
STEP ONE: Click on the “Offer Setup” tab, click on the “Which offer would you like to use for 

this event?” dropdown, then choose the applicable offer. 

 

 

 

 

 

 

 



STEP TWO: Fill in all Caption/Titling data & select all applicable product crests 

 

 

 

 

 

 

 

 

IMPORTANT: Fill in caption data on this screen that would apply ONLY FOR THE ENTIRE ORDER, 

such as the “Group Name”. 

IMPORTANT: Any caption data in the spreadsheet will override caption data entered here. 

To Choose the Applicable Crest: Click on the crest “Category” dropdown, then select 

“Business”. The Business crests will then load to the “Crest” dropdown below.  

 

 

 

 

 

 

 

 

 

 

 



Select the Appropriate Crest from the Dropdown. 

 

 

 

 

 

 

 

 

 

 

 
IMPORTANT:  When Finished click the “Save” Tab at the Bottom 

 

 

 

FIVE: SELECT A MODIFIER FOR THE EVENT 

STEP ONE: Select the “Edit Teams/Category” tab on the left hand side, then click the “Edit/Add 

Divisions” tab. 

 

 

 

 

 

 



STEP TWO: From the “Modifier” dropdown, select the applicable modifier then click the “Save” 

tab. 

 

NOTE: Once this step is complete, the event setup is finished. 



4.  ENABLE EVENT ON RETAIL 

STEP ONE: On the “Event Details” screen, click the “Enable event on Retail” tab. 

 

 

 

 

 

 

 

 

 

 

 

 

NOTE: Once the “Enable Event on Retail” tab is selected, it will take approximately 30 seconds 

for the event to be enabled.  

 

 

 

 

 

 

 

 

 



To Preview Event: 

Click on the “Event Details” tab on the left hand side to refresh the screen, then click on the 

“Preview Event” tab at the bottom. 

 

 

 

 

 

 

 

 

 

 

NOTE: If everything was done correctly, the pre-order site should look similar to the following: 

 

 



5.  CREATING SPLASH PAGE WITH PRE-ORDER LINK 

STEP ONE: On the homepage of the BizHub, click on the “Quick Links” tab, then select the 

“Marketing: Organization Splash Screens” tab. 

 

 

 

 

 

 

 

 

 

 

STEP TWO: Click on the “Create New” tab, then on the next screen click the “Create New 

Splash Page Now” tab. 

 

 

 

 

 

 

 

 



STEP THREE: Enter applicable data under “Shoot Information” section, then enter an event 

specific message AND the pre-order HTML code under the “Important Picture Day 

Information” section. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



ENTERING THE HTML CODE FOR THE PRE ORDER LINK: 

1. Use the link below to insert into the pre-order HTML code. 

IMPORTANT: YOU WILL NEED TO CHANGE THE “EVENT ID” IN THE LINK EVERY TIME YOU 

CREATE ANOTHER PRE-ORDER EVENT.  

IMPORTANT: YOU WILL ALSO NEED TO PUT YOUR FRANCHISEE SPECIFIC ACCOUNT 

NUMBER IN THE LINK AS WELL. 

 

 

 

 

 

 

 

 

 

 

 

 
NOTE: The event ID can be found on the “Event Details” screen of the specific event 

 

 

 

 

 

 

 



2. Paste the pre-order web link into the YELLOW section of the HTML code listed below: 

<a href="http://tss.partypics.com/QPPLUS/SearchNames.aspx?EventID=1554141& 

AccountNumber=91999"><h1 style="font-size:175%">CLICK HERE TO PREORDER YOUR 

PICTURES NOW</h1></a> 

IMPORTANT: REMEMBER TO CHANGE THE EVENT ID TO REPRESENT THE SPECIFIC EVENT AND 

THE ACCOUNT NUMBER TO REPRESENT YOUR SPECIFIC FRANCHISE 

 

3. Once the pre-order web link has been pasted into the HTML code, copy the ENTIRE 

HTML code and paste it into the “Important Picture Day Information” section of the 

splash page. Next click on the “Save Changes” tab. 

 

 

 

 

 

 

 

NOTE:  You can preview the splash page by clicking the “Preview” button at the top. 

 

 

 

 

 

 

 

 

http://tss.partypics.com/QPPLUS/SearchNames.aspx?EventID=1554141&


NOTE: If the HTML code was entered correctly, the following link should appear: 

 

 

 

 

 

 

 

 

 
IMPORTANT: THE REMAINING STEPS ARE OPTIONAL STEPS TO FINISH OUT THE SPLASH PAGE 

(with the exception of step seven) 

 

STEP FOUR: Upload any other desired documents by clicking the “Add/Remove Upload 

Documents” tab under the “Uploads” section.  

 

 

Click the “Choose File” tab. Browse for the desired document. Select the document and click 

the “Open” tab. Once the document has been selected, click on the “Upload” tab. 

 

 

 

 

 

 

 



IMPORTANT: This step just added the document to the splash page cloud. It did not add it to 

the specific splash page. You must complete the next step before the document will populate as 

a link on the splashpage. 

 

STEP FIVE: Display the newly uploaded documents by clicking on the “Add/Edit Links on this 

Splash Page”. 

 

 

 

 

From the “File” dropdown, select the file that you uploaded in the previous step. Type in link 

text in the “Link Text” box, then click the “Add” tab. Link will then appear in the box below.  

 

 

 

 

 

 

 

 

 

 

 

 

 

NOTE: When finished, click the “Back” button on your browser to return to the splash page 

control screen.  



STEP SIX: To add product images to the splash page, click on the “Update product spotlight” 

tab in the “Product Spotlight” section. 

 

 

 

Click on the “Search By” dropdown menu and select the method you want to search products 

by. Enter the appropriate data in the “Enter Description” box. Select the appropriate product 

when the text description populates in the “Select Product to Add” screen. When the correct 

product image populates in the “Product Spotlight” area, click the “Save Changes” tab. 

 

 

 

 

 

 

 

 

 

 

 

 

NOTE: Adding a caption for the product is optional. 

 

 

 

 



NOTE: Click the “Back to Splash Page Admin” tab to get back to the splash page control screen. 

NOTE: Once the splash page build is complete, click on the “Preview” tab at the top to see a 

preview of the splash page. 

 

 

 

 

 

 

SPLASH PAGE PREVIEW 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



STEP SEVEN: Send either the splash page URL or the web HTML code to the league/organization 

director. They can in turn either post it to the organization web page OR send the URL link to all 

of the parents in the organization.  

 

COPY & PAST THE URL:  

On the splash page preview screen, copy the URL for the splash page, then paste it into an 

email to the league/organization director/contact. 

 

 

 

 

 

 

 

 

 

SENDING THE WEB HTML CODE:  

Click on the “Web Code” tab at the top. 

 

 

 

 

 

 

 

 



On the next page, select the TSS Logo you want displayed, then highlight and copy the web 

code that appears in the box below. Paste the web code into an email and send to the 

league/organization director. 

 



6.  COLLECTING DATA ON PICTURE DAY 

IMPORTANT: Specific data must be collected on picture day to ensure proper data matching 
when processing the pre-orders. Data that needs to be collected: 
  

 Subjects First and Last Name  

 Subjects Image Number 

 Subjects Division 

 Subjects Modifier (Sport Type) 
 
IMPORTANT: Each photography station would need to be supplied with multiple copies of this 
form. 
 
NOTE: The Pre-Order tracking form was designed be used for this purpose. Downloadable from 
the BizHub (Library/CORE Training/Pre-Order Resources/Pre-Order Tracking Form). 
 
 
 
 
 

 

 

 

 

 

 

 

 

NOTE: It would also be helpful to have signage up on Picture day to inform any pre-order 

customers that they would need to inform the photographer of their pre-order status, so that 

the correct data can be collected from the customer.  



7.  MERGING PRE-ORDER DATA WITH PICTURE DAY ORDER DATA  

IMPORTANT: You must merge pre-order data with picture day order data, after picture day has 

taken place.  

IMPORTANT: The Pre-Order Tracking Form will be instrumental in this process. 

STEP ONE: Type all of the pre-order data (subject first and last name, subject image number, 

division and division modifier) into the same spreadsheet used to process picture day orders. 

 

 

 

 

 

 

 

 

NOTE: You can put these at the end of the spreadsheet as long as the correct division has been 

assigned to each subject. 

NOTE: Package data is not required, as that information was entered into CORE when the pre-

order was placed. 

STEP TWO: Upload Images 

NOTE: for detailed instructions on how to do this, please refer to the “Uploading Images” 

section in either the “Standard Order Entry” or the “Green Screen Order Entry” section of the 

CORE Manual. 

STEP THREE: Lock Rolls & Align Images 

NOTE: for detailed instructions on how to do this, please refer to the “Locking Rolls & Aligned 

Images” section in either the “Standard Order Entry” or the “Green Screen Order Entry” 

section of the CORE Manual. 

 



STEP FOUR: Upload the Spreadsheet (with the Pre-Order Data Included). 

NOTE: for detailed instructions on how to do this, please refer to the “Uploading the 

Spreadsheet” section in either the “Standard Order Entry” or the “Green Screen Order Entry” 

section of the CORE Manual. 

STEP FIVE: Import Pre-Orders 

Click on the “Imported Orders” tab on the left hand side, then click on the “Import Pre Orders” 

tab at the top. 

 

 

 

 

 

 

 

 

 

 

NOTE: Once the “Import Pre Orders” tab has been selected, any pre-orders will populate in the 

“Pre Orders” section. 

 

 

 

 

 

 

 



Match all pre-orders with the applicable name from the name dropdown menu, then click on 

the “Save Name Assignments” tab. 

 

 

 

 

 

 

 

 

 

 

NOTE: Once the “Save Name Assignments” tab has been selected, the pre-orders will then 

populate in the “Unprocessed Orders” section along with all of the picture day orders.  

 

 

 

 

 

 

 

 

 

 

 



STEP SIX: Transfer & Identify Group Images 

NOTE: for detailed instructions on how to do this, please refer to the “Transferring & 

Identifying Group Images” sections in either the “Standard Order Entry” or the “Green Screen 

Order Entry” section of the CORE Manual. 

STEP SEVEN: Queuing Orders for Transmit 

NOTE: for detailed instructions on how to do this, please refer to the “Queuing Orders for 

Transmit” section in either the “Standard Order Entry” or the “Green Screen Order Entry” 

section of the CORE Manual. 

STEP EIGHT: Transmitting Orders 

NOTE: for detailed instructions on how to do this, please refer to the “Transmitting Orders” 

section in either the “Standard Order Entry” or the “Green Screen Order Entry” section of the 

CORE Manual. 
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